
Rhythmyx 

Getting Started with 
Rhythmyx 

 Version 6.5.2 

 

 

 Printed on 9 May, 2007 





Copyright and Licensing Statement 
All intellectual property rights in the SOFTWARE and associated user documentation, implementation 
documentation, and reference documentation are owned by Percussion Software or its suppliers and are 
protected by United States and Canadian copyright laws, other applicable copyright laws, and 
international treaty provisions.  Percussion Software retains all rights, title, and interest not expressly 
grated.  You may either (a) make one (1) copy of the SOFTWARE solely for backup or archival purposes 
or (b) transfer the SOFTWARE to a single hard disk provided you keep the original solely for backup or 
archival purposes.  You must reproduce and include the copyright notice on any copy made.  You may not 
copy the user documentation accompanying the SOFTWARE. 

The information in Rhythmyx documentation is subject to change without notice and does not represent a 
commitment on the part of Percussion Software, Inc.  This document describes proprietary trade secrets of 
Percussion Software, Inc.  Licensees of this document must acknowledge the proprietary claims of 
Percussion Software, Inc., in advance of receiving this document or any software to which it refers, and 
must agree to hold the trade secrets in confidence for the sole use of Percussion Software, Inc. 

The software contains proprietary information of Percussion Software; it is provided under a license 
agreement containing restrictions on use and disclosure and is also protected by copyright law.  Reverse 
engineering of the software is prohibited. 

Due to continued product development this information may change without notice.  The information and 
intellectual property contained herein is confidential between Percussion Software and the client and 
remains the exclusive property of Percussion Software.  If you find any problems in the documentation, 
please report them to us in writing.  Percussion Software does not warrant that this document is error-free. 

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or 
by any means, electronic, mechanical, photocopying, recording or otherwise without the prior written 
permission of Percussion Software. 

Copyright © 1999-2007 Percussion Software. 
All rights reserved 

Licenses and Source Code 
Rhythmyx uses Mozilla's JavaScript C API.  See http://www.mozilla.org/source.html 
(http://www.mozilla.org/source.html) for the source code.  In addition, see the Mozilla Public License 
(http://www.mozilla.org/source.html). 

Netscape Public License  

Apache Software License 

IBM Public License 

Lesser GNU Public License 

Other Copyrights 
The Rhythmyx installation application was developed using InstallShield, which is a licensed and 
copyrighted by InstallShield Software Corporation. 

The Sprinta JDBC driver is licensed and copyrighted by I-NET Software Corporation. 

The Sentry Spellingchecker Engine Software Development Kit is licensed and copyrighted by Wintertree 
Software. 

 Printed on 9 May, 2007 

http://www.mozilla.org/source.html
http://www.mozilla.org/source.html


The Java™ 2 Runtime Environment is licensed and copyrighted by Sun Microsystems, Inc. 

The Oracle JDBC driver is licensed and copyrighted by Oracle Corporation. 

The Sybase JDBC driver is licensed and copyrighted by Sybase, Inc. 

The AS/400 driver is licensed and copyrighted by International Business Machines Corporation. 

The Ephox EditLive! for Java DHTML editor is licensed and copyrighted by Ephox, Inc. 

This product includes software developed by CDS Networks, Inc. 

The software contains proprietary information of Percussion Software; it is provided under a license 
agreement containing restrictions on use and disclosure and is also protected by copyright law.  Reverse 
engineering of the software is prohibited. 

Due to continued product development this information may change without notice.  The information and 
intellectual property contained herein is confidential between Percussion Software and the client and 
remains the exclusive property of Percussion Software.  If you find any problems in the documentation, 
please report them to us in writing.  Percussion Software does not warrant that this document is error-free. 

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or 
by any means, electronic, mechanical, photocopying, recording or otherwise without the prior written 
permission of Percussion Software. 

AuthorIT™ is a trademark of Optical Systems Corporation Ltd. 

Microsoft Word, Microsoft Office, Windows®, Window 95™, Window 98™, Windows NT®and MS-
DOS™ are trademarks of the Microsoft Corporation. 

This document was created using AuthorIT™, Total Document Creation (see AuthorIT Home - 
http://www.author-it.com). 

Schema documentation was created using XMLSpy™. 

Percussion Software 
600 Unicorn Park Drive 
Woburn, MA 01801 U.S.A. 
 781.438.9900 
Internet E-Mail: technical_support@percussion.com 
Website: http://www.percussion.com 

 

http://www.author-it.com/


 i 
 

Contents 

Introducing Rhythmyx FastForward for Web Content Management 3 
About FastForward for Web Content Management......................................................................................4 
Implementing FastForward...........................................................................................................................5 

Installing Rhythmyx in a Development Environment 7 
Preparing the Development Environment for Rhythmyx Installation...........................................................8 

Server Side ........................................................................................................................................8 
Client Side .........................................................................................................................................9 
Rhythmyx Repository........................................................................................................................9 

Installing Rhythmyx ...................................................................................................................................10 
Installing Rhythmyx on Windows/SQL Server ...............................................................................10 
Installing Rhythmyx on Solaris/Oracle ...........................................................................................29 

Starting the Rhythmyx Server.....................................................................................................................39 

Introduction to Content Explorer 41 
Logging in to Content Explorer ..................................................................................................................42 

Content Tab .....................................................................................................................................44 
Publishing Tab.................................................................................................................................46 
Workflow Tab .................................................................................................................................47 

Publishing FastForward for WCM Sample Content 49 
Running the FastForward for WCM Edition ..............................................................................................50 
Reviewing the Published Content...............................................................................................................53 
Publishing and Reviewing the Corporate Investments Site ........................................................................57 

A Brief Introduction to Rhythmyx 59 
A Brief Introduction to Content Explorer ...................................................................................................60 

The Content Explorer Banner..........................................................................................................61 
The Navigation Pane .......................................................................................................................62 
The Content Pane ............................................................................................................................63 
The Menu Bar..................................................................................................................................63 

Creating Content Items ...............................................................................................................................65 
Creating a Generic Page Content Item ............................................................................................65 
Creating a Generic Word Content Item ...........................................................................................68 
Creating an Image Content Item......................................................................................................69 

Working with Site Folders..........................................................................................................................72 
Creating the Education Folder .........................................................................................................72 
Moving Content into the Education Folder .....................................................................................74 
Adding Additional Content to the Education Folder .......................................................................76 

Active Assembly.........................................................................................................................................77 
Adding Links to Other Generic Pages in the Sidebar Slot...............................................................77 

 



ii Contents 
 

Adding an Image to a Generic Page ................................................................................................85 
Previewing the Content Item ...........................................................................................................87 

Workflow....................................................................................................................................................89 
Check In and Check Out..................................................................................................................89 
About Roles.....................................................................................................................................89 
Transitioning Content Items to a New State....................................................................................89 
About the Standard Workflow.........................................................................................................91 
Moving Content Items to Public......................................................................................................92 

Maintaining Managed Navigation for the Education Folder ......................................................................94 
Creating a Landing Page for the Education Folder..........................................................................94 
Making the Education Navon Content Item Public. ........................................................................96 

Publishing the Web Site with the Education Section..................................................................................97 
Successful Publisher Runs...............................................................................................................97 
Unsuccessful Publisher Runs...........................................................................................................99 

Troubleshooting 101 
Installation ................................................................................................................................................102 

Installer Cannot Connect to the Repository...................................................................................102 
Installer Hangs...............................................................................................................................103 
Server Shuts Down During Initialization.......................................................................................103 

Startup.......................................................................................................................................................104 
Rhythmyx License Period Expired................................................................................................104 
Out-of-Memory Condition Displayed on Rhythmyx Startup ........................................................104 
Publishing......................................................................................................................................104 

Index 107 

  

 



 3 
 

C H A P T E R  1  

Introducing Rhythmyx 
FastForward for Web Content 
Management 
The Rhythmyx Content Management System manages content through the automation of content creation, 
maintenance, and delivery, enhanced with features such as content reuse, delivery to multiple sites, 
intelligent relationships between content, and simple content assembly for business users.  

One of Rhythmyx’s key features is content reuse, which it achieves by separating content and formatting, 
enabling users to create a variety of outputs using the same data. Business users can assemble the same 
Content Items multiple times using different formats and include the Content Items in the output formats 
of other content. This enables Rhythmyx output pages to contain many Content Items assembled together.  

Another key feature of Rhythmyx is its ability to publish content to multiple sites. Rhythmyx allows any 
number of applications to be used to present published content to consumers since the content delivery 
mechanism (a portal, Web server, or other application) is not connected or “coupled” to Rhythmyx. This 
“decoupled delivery” not only offers companies flexibility in choosing delivery applications, but also 
simplifies the process of delivering content to multiple media. 

This document will help implementers get started with Rhythmyx by installing it with its “FastForward” 
sample components and Content Items, starting the Rhythmyx Server, and publishing sample content. For 
more details about content creation, reuse, and delivery, and conceptual information about content 
assembly and intelligent relationships, see the Rhythmyx Concepts Guide.  
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About FastForward for Web Content 
Management 
Rhythmyx FastForward for Web Content Management (FFWCM) is reference implementation available 
with Rhythmyx.  FastFoward includes a set of pre-built components and applications that allow a 
company to quickly bring their Web site under management. These pre-built components include 
definitions for the types of content and outputs most commonly implemented by customers and elements 
for setting up typical publishing and authentication scenarios. This document includes instructions for 
installing and reviewing these components. 
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Implementing FastForward 
Install, configure, and implement FastForward in a development environment and then test your features 
in a test environment.  After development and testing is complete, migrate your Rhythmyx components to 
the production environment where your end users perform their work. This process ensures that end users 
only have access to completed, tested components and features. 

Before reading this document, read the Rhythmyx Concepts Guide for a basic understanding of the 
concepts and operation of Rhythmyx.  Then use this to guide you through the process of installing 
Rhythmyx with FastForward and testing that the installation was successful and that it is publishing 
content as expected.  This document also includes a "guided tour" of Rhythmyx functionality.   

After reading this document, use the following documents to guide you through the process of designing 
and implementing your Rhythmyx Content Management System. 

 Modelling and Design of a Rhythmyx Content Management System 
This document outlines the process of modeling your content and designing a CMS 
implementation to meet your needs. 

  Rhythmyx Implementation Guide  
This document explains the common tasks of implementing a Rhythmyx CMS by illustrating 
the implementation of selected elements of FastForward. 

 Setting up the Rhythmyx Production Environment 
This document explains how to set up the production environment and deploy your 
implementation from your development environment to that production environment. 

 

 
 

 





 7 
 

C H A P T E R  2  

Installing Rhythmyx in a 
Development Environment 
In the recommended Rhythmyx environment, implementers create new Rhythmyx elements and features 
on a development server, perform user testing on a testing server, and install tested, new functionality to a 
production server.  In technical terms, this is called a multi-tiered environment, and each Server level 
represents a tier. 

 

 
Figure 1: A multi-tiered environment includes development, testing and production tiers. 

It is important to implement FastForward on a separate development tier and integrate and test completed 
development work on a testing tier. On the development tier, configure Site structures and develop 
Rhythmyx applications and elements.  On the testing tier, integrate all development work and determine if 
it functions as expected. Since features in development and testing states tend to be incomplete and 
unstable, they should never be accessible on the production tier, where users are creating and publishing 
actual content. Once testing is complete, move new components to the production tier. 

A Web Server must be installed on each tier to test or perform publishing. Implementers should 
successfully publish the sample content on the development tier before configuration is deployed to an 
integrated testing tier and then a production tier. 
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Preparing the Development Environment for 
Rhythmyx Installation 
In order to install Rhythmyx with FastForward, your development tier must meet the following 
requirements: 
 

Server Side 
The Rhythmyx Server must be installed on one of the following supported Operating Systems.  The size 
requirements for both the development and production tiers are noted: 

 Sun Solaris 7, 8, 9 

Development Production 
UltraSPARC 10 or higher V120 or Higher recommended 

RAM - 512 MB RAM – 2 GB 

Disk Space - 700 MB Disk Space – 700 MB 

 Microsoft Windows 2000 (Professional, Server, Advanced Server and Datacenter Server), 
Windows 2003 Server platform. 

Development Production 
Processor - 1 Ghz+ Processor - 2 Ghz+ 

RAM - 512 MB+ RAM – 1+ GB 

Disk Space - 700 MB Disk Space – 700 MB 

 Linux (Certified on Red Hat Linux AS 3.0+; Other distributions supported; Linux OS certified 
on Intel-based hardware.) 

Development Production 
Processor - 1 Ghz Processor - 2 Ghz 

RAM - 512 MB RAM - 1+ GB 

Disk Space - 700 MB Disk Space - 700 MB 
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Client Side 
One of the following browsers must be installed to support content contribution, Workflow, and 
Publishing: 

 Internet Explorer V6.0+  
 Firefox 1.0 and 1.5 
 Safari 1.02 

In order to use the Rhythmyx Connector for Word, your system must have one of the following versions 
of Microsoft Office Client installed: 

 Word 2000, 2002/XP or higher  
 Functionality limited in Word 97 

The supported version of Java JRE is 1.5.0_08.  

In order for implementers to use the Rhythmyx Workbench, one of the following supported environments 
must be installed: 

 Windows XP  
 Windows 2000  

The following hardware is required to use the Workbench: 

 Processor - P4 1.0 GHz or higher recommended  
 RAM - MIN 1 GB recommended  
 Disk Space - MIN 350 MB to run installed product (1 GB during install) 

Rhythmyx supports he following versions and working drafts of standard Web technologies: 

 XML V1.0  
 XSLT V1.0  
 HTML V4.0+  
 XHTML V1.0  
 Velocity V1.4 

 

Rhythmyx Repository 
Rhythmyx stores its data in an external relational database.  Your system must include one of the 
supported Databases: 

Oracle 9.2i  

Oracle 10g 

MS SQL Server 2000  

MS SQL Server 2005 

DB2 UDB 8.02  
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Installing Rhythmyx 
Rhythmyx provides Installers for Windows and Unix.  The following section demonstrates the sequence 
for installing Rhythmyx with FastForward for Windows using an MS SQL database; however, you may 
install with any of the supported databases. You must install your database prior to completing the 
installation steps in this section. 

Use the defaults specified in the installation sequence.  To set up your system to use the defaults: 

 In your repository, define a new schema or database named RXMASTER. During installation, 
you will specify RXMASTER as Rhythmyx’s backend database. 

 If you are currently using port 9992 free it. Port 9992 is the default Rhythmyx Server port. 
You must enter your license number and installation code to install Rhythmyx.  They are located on the 
back of your CD jacket. 
 

Installing Rhythmyx on Windows/SQL Server 
To install Rhythmyx with FastForward for Windows: 

1 Insert your installation CD. In the Startup folder, double-click on setup.exe, the setup program 
for Windows. 
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After a few seconds, the Installer displays a splash screen and then opens the Welcome 
screen: 

 
Figure 2: Welcome screen 

2 Click [Next]. 
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The installation wizard displays the license agreement dialog. 

 
Figure 3: License agreement 

3 Click the I accept the terms of the license agreement radio button and click the [Next >>] 
button. 
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The installation wizard displays the Choose Installation Type dialog. 

 
Figure 4: Installation Type dialog 

4 Choose New Install and click [Next]. 
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The installation wizard displays the Installation Directory dialog. 

 
Figure 5: Installation Directory screen 

5 The Directory field defaults to C:\Rhythmyx.  If you want to install to a different directory, you 
can enter it in the Directory field, or click the [Browse] button and browse to the location 
where you want to install Rhythmyx.  Once you have defined the directory where you want to 
install, click the [Next >>] button. 

If the directory does not already exist, the installation wizard will ask if you want to create the 
directory.  Click the [Yes] button to create the directory.   

6 Click the [Next >>] button. 
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The installation wizard displays the Select the products you would like to install dialog. 

 
Figure 6: Select the products you would like to install dialog 

7 Uncheck Rhythmyx Enterprise Content Connector and Rhythmyx Full Text Search. Leave the 
other components checked to fully implement FastForward. Click [Next]. 
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The installation wizard displays the Select Publisher Features dialog. 

 
Figure 7: Select Publisher Features dialog 

8 Leave all boxes on this dialog unchecked.  Click the [Next >>] button. 
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The install wizard displays the FastForward features dialog. 

 
Figure 8: FastForward Features Selection screen 

9 Check both FastForward Applications and FastForward Sample Content. (NOTE:  These 
boxes are checked by default) Click [Next]. 
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The install wizard displays the Rhythmyx Server Type dialog. 

 
Figure 9: Select Server Type dialog 

10 Leave System Master as the Rhythmyx Server Type.  The other option (Publishing Hub) is not 
a valid development environment.  Click the [Next >>] button. 
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The install wizard displays the Installation Information dialog 

 
Figure 10: Installation Information dialog 

11 Enter the license number and installation code, which you can find on the back of the CD 
jacket.  Click the [Next >>] button. 
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The installation wizard displays the license summary dialog, which lists the components you 
are licensed to install.  

 
Figure 11: License summary dialog 

12 Click the [Next >>] button. 
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The installation wizard displays the Repository Database Selection dialog. 

 
Figure 12: Repository Database Selection dialog 

13 In this example, we choose jtds:sqlserver. You should choose the option in the drop list that 
matches your database. Click [Next]. 
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The installation wizard displays the Repository Database Definition dialog. 

 
Figure 13: Repository Database Definition dialog 

14 In the Database Server field, enter //localhost (or the name or IP address of the machine where 
the SQLServer database resides if it is not local).  (NOTE:  The jtds driver requires the double 
backslashes (//) in the server specification.  If you have specified a port other than the default 
{1433} for your SQL server installation, you must also specify the port {for example:  
//localhost:1433}.  If you use a SQL Server instance, you must specify the instance as well:  
//localhost:1422;instance=Rhythmyx.)  In the Login ID field, enter the login ID of your SQL 
Server installation (the default user is sa).  In the Password field, enter the password of the 
user used to log in to the database.  Click the [Next >>] button. 

 



 Chapter 2    Installing Rhythmyx in a Development Environment 23 
 
 

The installation wizard displays the Schema and Database Definition dialog. 

 
Figure 14: Schema and Database Definition dialog 

15 If you defined a database owner other than the default dbo owner, choose the owner from the 
Schema/Owner drop list.  (In most cases, you can leave the default {dbo} selected.)  In the 
Database drop list, choose rxmaster.  The default name for the datasource configuration used 
to connect to the database is RhythmyxData, but you can change the name if you prefer.  Click 
the [Next >>] button. 
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The installation wizard displays the Rhythmyx Service Properties dialog 

 
Figure 15: Rhythmyx Service Properties dialog 

16 For the purposes of this procedure, we will use the default name (Rhythmyx) and description 
(Percussion Rhythmyx) of the Rhythmyx service.  Click the [Next >>] button. 
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The installation wizard displays the Rhythmyx Server Settings dialog. 

 
Figure 16: Rhythmyx Server Settings dialog 

17 We will use the default port (9992).  Click the [Next >>] button. 
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The installation wizard displays the Full Text Search Settings dialog 

 
Figure 17: Full-text Search Settings dialog 

18 If you want to set up full text search on the local machine, accept the defaults for the search 
engine host name and the search target install location. (See the Note below for information on 
choosing a port.)  If you want to set up the Full-text search engine on a remote machine see 
(need appendix on setting up remote FTS engine).  Click the [Next >>] button. 

NOTE: Percussion Software recommends that you choose unique search port numbers other than the 
default port number (9993) for each installation of Rhythmyx with full text search within the same 
network, whether it is a development or a production installation. Choosing unique search port 
numbers avoids a potential conflict with search results that can occur when two Rhythmyx servers on 
the same network use the same search port number.  
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The installation wizard displays the Application Server Settings dialog.   

 
19 This dialog lists the ports that will be used by the Rhythmyx server and its container.  Review 

these ports to ensure that they are not already in use.  If necessary, change these ports. Click 
the [Next >>] button. 
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The install wizard displays the installation summary dialog.   

 
Figure 18: Installation summary dialog 

20 Click the [Next >>] button. 

The install wizard launches the installation process.  When the installation process, the install 
wizard displays the readme. 

21 Review the readme.  Click [Next].  Click [Finish] to exit the Installer. 
 

 



 Chapter 2    Installing Rhythmyx in a Development Environment 29 
 
 

Installing Rhythmyx on Solaris/Oracle 
NOTE: Before beginning the Rhythmyx installation, define a schema named rxmaster in Oracle that will 
serve as your Rhythmyx data repository. You must also have a login ID and password for the Solaris and 
Oracle servers. Contact your system or database administrator to obtain the necessary Solaris and Oracle 
accounts. 

IMPORTANT REQUIREMENT: To open the Rhythmyx server installed in a UNIX environment, you 
must install the GNU Compiler Collection (GCC), Version 3.2.2 or higher. You can download GCC from 
www.freeware.com. Install GCC to either /usr/local/lib or /usr/lib; otherwise, you will have to modify the 
environment variable LD_LIBRARY_PATH (for the user account under which Rhythmyx is installed) to 
include the GCC path you use. 

To install Rhythmyx with FastForward on a development Solaris platform with an Oracle backend, using 
the command line: 

1 Create (or have your administrator create) a user in Solaris to install and run Rhythmyx. (If 
you run multiple instances of the Rhythmyx server, create a user for each instance.) The user 
you create must be the owner of all files copied from the CD-ROM; must have read 
permissions on all installer files; and must have execute and read permissions on the following 
files: 

 suite.so 

 SetupConsole.sh 

NOTE: You must log in as this same user to run Rhythmyx and perform upgrades. 

2 Copy the contents of the installation CD-ROM to the install user's home directory 
(/export/home/username). (You cannot run the Solaris installation directly from the CD-
ROM.) 

3 From the install user's home directory, change to the directory containing the Rhythmyx setup 
installation files. 

$ cd rxinstaller/setup 

4 Run the shell script SetupConsole.sh. 
$ sh SetupConsole.sh 

NOTE: If you receive a message about insufficient disk space, create a temporary directory under the 
install user's home directory called tmp.   

$ cd /export/home/username  

$ mkdir tmp 

Then run the install script again, using this command line: 

$ sh SetupConsole.sh -is:tempdir /export/home/username/tmp 
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5 The InstallShield Wizard is launched and displays the following text. Enter 1 and press Enter 
to continue. 

 
Figure 19: Install Wizard Welcome 

6 Press Enter to read the license agreement and enter q to quit when you have finished. 

  
Figure 20: Software License and Support Agreement 
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7 Enter 1 and press Enter to accept the terms of the license agreement.  

 
Figure 21: Accepting the License Agreement 

8 Enter 0 and press Enter to quit out of the prompt. (If you don’t enter 0, the script keeps 
prompting you to accept the license agreement.) 

 
Figure 22: Quitting the License Agreement Prompt 

9 The script displays information about the need to create a user ID to run the Rhythmyx 
installation, run Rhythmyx, and perform updates to the installation in the future. (Note that 
when performing an update, this user must also have read and write permissions on all the 
files under the Rhythmyx root directory.) You should have already created this user in step 1 
of this procedure. Create the user ID if necessary and enter 1 to continue.  

 .  

Figure 23: Reminder to Create Install User in Solaris 

10 Enter 1 and press Enter for new install. 

 
Figure 24: New or Upgrade Installation Prompt 
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11 Rhythmyx displays the default location for the installation, which is under the install user's 
home directory. Press Enter to accept the default and continue. 

 
Figure 25: Installation Directory Prompt 

12 The script asks if you want to create the installation directory if it doesn't exist. Enter 1 and 
press Enter to create the directory and continue. 

 
Figure 26: Prompt to Create the Installation Directory 

13 Set the install user permissions (according to the information in the following prompt) on all 
files under the Rhythmyx root installation directory, if necessary. Enter 1 and press Enter to 
continue. 

 
Figure 27: User Permissions Prompt 

14 Deselect the following products from the installation options list (they aren't necessary in the 
development environment):  

 Rhythmyx Enterprise Content Connector 

 Rhythmyx Full Text Search 
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To deselect a product, enter its number at the prompt, press Enter, and follow the on-screen 
instructions. Then deselect the next product. When you have finished deselecting products, 
enter 0 and press Enter to continue with the installation. The following dialog shows how to 
deselect Full Text Search; Enterprise Content Connector is already deselected in this example. 

 
Figure 28: Deselecting Install Options 

The following screen shot shows the recommended configuration of this dialog for the 
development server installation: 

 
Figure 29: Products to Deselect in Development Environment 

 



34 Rhythmyx Getting Started with Rhythmyx 
 

15 Do not select either of the two features displayed for the Rhythmyx Publisher. Enter 0 and 
press Enter to continue with the installation. 

 
Figure 30: Publisher Options 

16 Accept the default selection of both Fast Forward features and enter 0 to continue. 

 
Figure 31: Selecting FastForward Applications 

17 Specify the type of Rhythmyx server you want to install. Enter 1 and press Enter to choose 
System Master, which is used in most situations. 

 
Figure 32: Choosing the Rhythmyx Server Type 

18 Enter your license number and installation code, which you can find on the back of the install 
CD-ROM jacket. (The number and code shown below are only examples.) 
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NOTE: Remember that the license number and installation code are only good for 30 days. After 30 
days, contact Percussion Software, Inc. Technical Support for a new number. 

 
Figure 33: Entering the License Number 

19 The installer displays a summary of the Rhythmyx features you are licensed to install. 
Confirm that the correct components are listed; enter 1 and press Enter to continue. 

 
Figure 34: Rhythmyx Features Licensed to Install 

20 Define the Jdbc subprotocol to connect to your database. For an Oracle database, enter 2 and 
press Enter for oracle:thin. 

 
Figure 35: Database Subprotocol Selection 
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21 Rhythmyx asks you to enter the database server name. The installer automatically fills in for 
you the name of the server on which you are installing Rhythmyx. If this is where your 
database is, press Enter to continue. If your database is on a different machine, enter the IP 
address or host name for that machine, the port number, and the SID and press Enter. 
Remember to insert the @ sign before the IP address or host name. 

 
 

22 Enter your Oracle login ID and password; then enter 1 and press Enter to continue. 

 
Figure 36: Oracle Login ID and Password 

23 If the connection to the database is successful, you see a message similar to the one shown 
below. 

Connecting to : jdbc:oracle:thin:@255.255.255.92:1521:ORCL 
Connecting to : jdbc:oracle:thin:@255.255.255.92:1521:ORCL 

NOTE: If the installer cannot connect to the database successfully, check that you entered the 
following data correctly: the database host machine IP address or host name, port number, SID, and 
the database user login ID and password. If these are correct, be sure the two servers can 
communicate, for example, be sure both servers are running and that there is no problem such as a 
firewall configuration that prevents access. 

24 If the connection to the database is successful, the installer displays a list of schema names. At 
the prompt, enter the number for the schema that will serve as your Rhythmyx data repository 
-- rxmaster -- and press Enter. 

 
Figure 37: Select Schema Name 
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25 After the installation wizard connects to the schema you specify, it asks you to specify a name 
for the Datasource configuration.  The default name for the Datasource configuration is 
Rhythmyx Data, but you can change it to another name if you prefer. 

 
Figure 38: Datasource configuration 

26 Accept the default bindPort number of 9992 by pressing Enter. (The bind port number must 
be in the range 1025 through 65535, as numbers 1 through 1024 are reserved by many 
companies.) 

 
Figure 39: Choose Bind Port Number 

27 The installer displays a warning that all port numbers in the installation must be unique. 
Follow the instructions to change the port number, if necessary, or press Enter to continue. If 
you wish, you can enter 1 at the prompt to prevent the installer from displaying this warning 
message in the future. 

 
Figure 40: Unique Port Number Warning 

28 After you define the full-text search configuration, the installation wizard displays a set of 
application server ports.  These ports are used internally by the Rhythmyx application server.  
check to confirm that these ports are not in use.  If any of the ports are in use, change the port 
to one that is not in use. 

 
Figure 41: Appliation Server Port Listings 

 



38 Rhythmyx Getting Started with Rhythmyx 
 

29 Enter 1 and press Enter to confirm the display of location and features for your Rhythmyx 
installation. The features listed should include the Rhythmyx Repository Database, Rhythmyx 
Server, Rhythmyx Publisher, and Rhythmyx FastForward. 

 
Figure 42: Confirm Rhythmx Installation Features and Location 

30 The installation runs, displaying a progress bar and a list of extensions it is installing. 
Periodically, it displays other messages indicating what is being installed, for example: 

 
Figure 43: Rhythmyx Installation Progress Messages 

Post-Installation Steps 
When the installation is complete, follow these steps: 

1 Read the readme.txt file in the Rhythmyx root installation directory. It contains information 
that could be very important to you. 

2 To enable auto-startup of Rhythmyx, run the InstallDaemon.sh script located in the Rhythmyx 
root directory.This script must be run as root. 

3 Source the .profile file to update the environment variables for the current shell. 
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Starting the Rhythmyx Server 
To start the Rhythmyx Server in Windows, in your Rhythmyx root directory, double-click on the file 
RhythmyxServer.exe. A terminal window should open and list the progress of the Server initialization. 
When the terminal window displays the message “Started in...”, the Rhythmyx Server is up and running: 

 
Figure 44: Rhythmyx Server Console 

If you have problems starting the Rhythmyx Server, see Startup (on page 104) in the Troubleshooting 
section of this document. 
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C H A P T E R  3  

Introduction to Content Explorer 
Content Explorer is the default home page Rhythmyx displays when any user logs in to the Rhythmyx 
Content Management System. Content Explorer gives business users access to Content Item 
administration functions such as create, approve, and copy, and gives implementers and administrators 
access to Publishing and Workflow setup screens. 

 
Figure 45: Content Explorer 

The following sections explain how to log in to Content Explorer and summarize the functions of each of 
its tabs. 
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Logging in to Content Explorer 
To log into Content Explorer: 

1 Open one of the supported Web browsers and navigate to http://servername:port/Rhythmyx 
where servername:port describes the location of the Rhythmyx server.  For example, if your 
Rhythmyx Server is named contentmanager and you are using the default port 9992, enter 
http://contentmanager:9992/Rhythmyx.  

Rhythmyx prompts you to log in.  

 
Figure 46: Login Dialog 

2 Enter the User name admin1 and the Password demo, and click [OK]. 
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Rhythmyx opens Content Explorer.  The Content tab is selected, and all three tabs are 
displayed. In the upper-right corner, the Status Box displays the Login User Name, admin1.  
The Roles that the user belongs to do not fit in the available space, but Rhythmyx displays 
those that do with an ellipsis (...) to indicate that the user belongs to more Roles.  
FastForward’s only Locale is US English, so the Status Box does not display a Locale. 

 
Figure 47: Content Explorer 

3 Hold your cursor over the word Admin or click on it. 

Content Explorer displays all of the User’s Roles: 

 
Figure 48: User Roles 

The Site Folders in your navigation pane should appear identical to those in the Content 
Explorer graphic above. 
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Content Tab 
In the Content Tab, business users create and modify Content Items and transition them into Workflow 
States. This tab also allows users to actively assemble Content Items as pages or portions of pages and 
preview the results. 

The Content tab appears and functions similarly to the Windows Explorer interface: the left pane displays 
a Navigation Tree and the right pane is a Display pane that lists the contents of the node selected in the 
Navigation Tree. 

 
Figure 49: Content Tab of Content Explorer 

Several of the components labeled on the Content tab graphic above are present in Content Explorer 
regardless of the tab selected.  These components include the Rhythmyx banner, which displays the 
product name, the Session Properties box, which displays the login User Name, Roles, Community, and 
Locale (if the system includes more than one Locale), and  tabs for accessing other pages.  Only the tabs 
for pages that the user may access are visible.  If the user only has access to the Content tab, no tabs are 
visible. 

The Navigation pane includes four main nodes that represent different ways of navigating Content Items: 

 Sites – Provides users with a location for setting up a folder tree that resembles the structure 
of an external site or sites.    

 Folders  – Contains folders that contain sub-folders or Content Items. 
 Views  – Contains views that display content sorted and selected according to predefined 

parameters. 
 Searches  – Contains search queries. 
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When a user selects a node in the Navigation Tree, the Display Pane displays it contents.  In the Display 
Pane, users can select a Content Item and right-click to open a menu of options for acting on it. 

The Content tab also includes a Menu Bar with drop menus that include the various actions available to 
users in the Content tab. 

To the right of the Menu bar, the Content Path displays the full path of the component selected in the 
Navigation pane. 

For more information about the Content tab, see the online Content Explorer help. 
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Publishing Tab 
The Publishing tab includes links to pages for configuring publishing components and viewing details of 
published Editions. The default screen displays the Publication Logs by Site.  At this point, you have not 
published anything, so your default page should list no logs. Click the Publishers – By Name link to view 
the Publishers page. Your Publisher’s page should appear identical to the following graphic, with only the 
publisher named Localhost Publisher Default Port listed. 

 
Figure 50: Publishing Tab of Content Explorer 

For more details about pages available from the Publishing tab, see the document CMS Online Help or the 
Rhythmyx Implementer's Guide. 
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Workflow Tab 
A Rhythmyx Workflow is a set of States that a Content Item progresses through during its lifetime. In 
general, Content Items are published after they pass through one or more approval States and reach a 
publish State.  

The following graphic shows how the default Workflow tab appears when FastForward is installed.  Your 
Workflow tab should also display the Simple and Standard Workflows. 

 
Figure 51: Workflow Tab 

For more information about Workflows and the Workflow tab, see the CMS Online Help or the document 
Rhythmyx Implementation Guide. 
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C H A P T E R  4  

Publishing FastForward for WCM 
Sample Content 
This section shows you how to publish the content of the FastForward Web Site Enterprise Investments.  
The FastForward publishing configuration is set up to publish the content to the JBOSS application server 
installed with Rhythmyx.   
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Running the FastForward for WCM Edition 
In Content Explorer, click on the Publishing tab.  In the left navigation bar, under Editions, click on the By 
Name link.  Content Explorer displays the Editions page. 

 
Figure 52: Editions page 

Rhythmyx uses Editions to publish content. The Edition specifies the content to publish, and Site or 
location where you want to publish it.  The Full Enterprise Investments Edition publishes all Public 
Content Items in the Enterprise Investments Site in Rhythmyx to the JBOSS application server.  We will 
run this Edition manually to illustrate how Publishing an Edition works.  In a production environment, a 
scheduling application usually triggers the Editions automatically. 

To manually publish the Enterprise Investments Edition, on the Editions page, find the Full Enterprise 
Investments Edition, and click on the manual publish icon  in the Publish column. 

As the Edition begins to run, Rhythmyx displays the following screen: 

 
Figure 53: Publisher Status: Publishing is initiated 

As publishing progresses, Rhythmyx may display: 
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Figure 54: Currently published Content List 

When publishing is complete, Rhythmyx displays: 

 
Figure 55: Publisher Status: Edition is not in progress 

To check that the edition has run successfully: 

1 Click the Publishing tab again. 

2 In the Navigation pane, click Publishing Log, By Site. 

Under the Enterprise Investments Site, two entries for your publication appear, one for each 
Content List that published, rffEIFullBinary and rffEIFullNonBinary.  (Since no Content 
Items were marked for unpublishing, the third Content List in the Edition, rffEIUnpublish, did 
not publish and is not listed.) 

 
Figure 56: Publishing log 

3 To confirm that each Content List published successfully, check that the Status column for the 
Content List says Success.   

4 Then check the numbers under the icons to the right of the Publishing Log. If you haven't 
changed the State of any of your Content Items, you should only see a count of the number of 
Content Items under the inserted content items icon:  

The icons represent the following actions on items: 

  - Inserted Content Items 

  - Updated Content Items 

  - Removed Content Items 
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  - Skipped Content Items 

  - Content Items that generated errors 

5 Now click on the first link in the Date/Time (Publication ID/Pubstatus ID) column to see the 
Site map for the content items published in the rffEiFullBinary Content List. The Site map 
should appear similar to: 

 
Figure 57: Publication Map 
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Reviewing the Published Content 
After you publish your FastForward content, you can review it in two ways:   

 Check the Publication Log (Publog) for the publication run of the Edition.   
 Open the Web Site in a browser and browse the Site. 

If your Publog and published site do not resemble the data in the following sections, refer to Publishing 
(on page 104) in the Troubleshooting section of this document. 

To review published content: 

1 Click the Publishing tab in Content Explorer and click one of the Publication Log links. 
Locate the logs for your Publication (they may be the only logs listed). 

 
Figure 58: Publishing log 

2 Review the log as follows: 

 Check if the Status column displays Success. If it displays Error, click Error to locate 
the source of your error in the error log. 

 Determine if the page icons in the columns to the right display the following numbers: 

 
Figure 59: Items published 

If the numbers displayed do not match these, either: 

o click on Success to view the publishing log, or 

o click on the entry in the column Date/Time (Publication ID:Pubstatus ID) to 
view the status of individual Content Items published. 

 Click on the entry for each column Date/Time (Publication ID:Pubstatus ID). Review 
each Publication map to determine if individual Content Items published to the 
expected folders and if they published successfully. 
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 Click on the filenames or CMS links to see if the Content Items are assembled as 
expected. 

 
Figure 60: Publication Map 

3 Open the Site directory on your local machine.  The directory is <Rhythmyx 
root>\AppServer\server\rx\deploy\EI_Home.war. 
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The directory should list the following folders and files.  Note that some of the folders hold 
files used for rendering the Web Site. 

 
Figure 61: Published Enterprise Investments content 

 
The Site folder structure should be similar to that of your Site Folder structure on Content 
Explorer: 

 
Figure 62: Site Folder Structure in Content Explorer 

Open some of the folders and check if the Publisher delivered the expected Content Items to 
the folders. 

4 Enter http://localhost:9992/EI_Home/index.html in your browser. 
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The home page for Enterprise Investments should open: 

 
Figure 63: Published Enterprise Investments Generic Page 

Browse through the Site to determine if it looks as expected. . 
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Publishing and Reviewing the Corporate 
Investments Site 
A second sample Site, Corporate Investments, is also provided.  To publish this Site, run the Full 
Corporate Investments Edition.  When you review the Publog, you should see the following: 

 
Figure 64: Corporate Investments Publog 

The URL for the published Corporate Investments Web Site is: 
http://localhost:9992/CI_Home/index.html 
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C H A P T E R  5  

A Brief Introduction to Rhythmyx 
Before proceeding with the tasks of customizing your Rhythmyx FastForward installation, you should 
become more familiar with Rhythmyx and its operations.  This chapter provides a brief walk-through of 
the major functionality of the Rhythmyx Content Management System.  We will add a several new 
Content Items to the Enterprise Investments Web site.  We will add this content to a new "Education" 
subsection of the "Investment Advice" section of the Enterprise Investments Web site. 
 

 



60 Rhythmyx Getting Started with Rhythmyx 
 

A Brief Introduction to Content Explorer 
Begin the walk-through by logging in to Content Explorer.   

To access Content Explorer, start your browser and enter the following URL into the address field: 
http://localhost:9992/Rhythmyx 

This URL assumes that the server is installed locally and that you are using the default Rhythmyx port.  If 
you are accessing the server from a different machine, replace localhost with the name or IP address 
of that machine.  If you chose a different port for Rhythmyx, replace 9992 with your preferred port 
number.  Note too that the URL is case-sensitive, so you must capitalize the "R" in "Rhythmyx.  (The 
case-sensitivity is a characteristic of the underlying Java code used in Rhythmyx.)  If you enter the URL 
using a lowercase "r", Rhythmyx returns a message that A handler could not be found to 
handle the request for (/rhythmyx/.xml). 

When you successfully access the server, your browser displays a login dialog.  Use the user name 
author1 and the password demo to log in to Content Explorer.  (The user "author1" is a default user 
provided by Percussion Software that has authorship rights in Content Explorer.) 

Content Explorer uses a Java applet.  When installing the applet, your browser displays a security dialog.  
Click the [Yes] button to allow the applet to install on your browser. 

When the applet finishes loading, your browser displays the Content Explorer window: 

 
Figure 65: Content Explorer when you first log in 
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Content Explorer consists of four sections:   

 the banner 
 the navigation pane 
 the content pane  
 the menu bar. 

 

The Content Explorer Banner 
The banner consists of the Rhythmyx logo, the Logout button, and the login information at the far right. 

 
Figure 66: Rhythmyx Banner 

The login information consists of three pieces of data: 

 User:  The name of the user logged in to the system, in this case, author1 
 Roles:  The Roles into which the logged in user has been authenticated.  If you hover your 

mouse over the value of the Roles field, Rhythmyx displays a popup listing all of the Roles 
into which the user has been authenticated.  The value of the Roles field is also a link.  You 
can click on this link to display a popup window with the user's list of Roles as well.  The 
graphics below illustrate both options: 

 
Figure 67: List of user's Roles 

 
Figure 68: Popup with Roles 

 Community:  The Rhythmyx Community into which the user is currently logged.  The 
author1 user is initially logged in to the Enterprise Investments Community, as illustrated in 
the screenshot above. 
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The Navigation Pane 
The Navigation Pane provides you with options for locating and organizing Content Items.   

 
Figure 69: The Content Explorer Navigation Pane as displayed when first accessed 

The Navigation Pane consists of four main Nodes: 

 The Sites node is used to define Site structures and to assign Content Items to those Sites.  
When Rhythmyx publishes the content, it creates a directory structure on the target Web 
server identical to the structure you define under this node.  Published pages are output to the 
directory parallel to the Content Explorer Site Folder to which they have been assigned. 

 The Folders node consists of Folders used strictly to organize Content Items.  The folder 
structures created under this node are not used in Publishing but for personalized organization. 

 The Views node consists of a set of pre-defined queries that return lists of content.  View fall 
into four categories. 

 My Content Views 

This category is the richest set of default Views.  Views in this category list Content 
Items checked out to the logged user, Content Items assigned to the logged user, 
Content Items the user has worked on recently, and Content Items created by the 
user. 

 Community Content Views 

This category consists of Views that list Content Items only in the current 
Community of the user. 

 All Content Views 

This category consists of Views that can list all Content Items in the system, 
regardless of their Community or current Workflow State.   

 Other Content Views 

This generic category consists of Views that do not fit in any of the other categories. 
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 The Searches node consists of the New Search query and several pre-defined search queries.  
Searches are somewhat simpler than Views.  Views can query based on system data not 
available to searches.   

For more details about any of these nodes, see the Content Explorer Help, which you can access by 
choosing Help > Content Explorer from the Menu Bar. 
 

The Content Pane 
The larger area to the right on the Content Explorer is the Content Pane.   

 
Figure 70: Content Pane as displayed when you first log in to Content Explorer 

When you initially log in to Content Explorer, the default navigation selection is always the Recent View.  
Since you have not logged in before and have not worked with any Content Items to this point, this View 
has no results, as illustrated in the graphic above, which shows the text "No search results to display". 

Expand the Sites node, and select the Enterprise Investments Folder.  Now the Content Pane lists the 
contents of this Folder.  This Folder includes a number of Subfolders (such as About Enterprise 
Investments, Investment Advice, and Products and Services) and a couple of Content Items (EI Home 
Page and Enterprise Investments Internet Root). 
 

The Menu Bar 
The Menu bar separates the banner from the Navigation and Content Panes.   

The Menu bar consists of four menu options and the Content Path.  The Content Path lists the Navigation 
path to the object currently selected in the Navigation Pane. 
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The following Menu options are available: 

 Content 
The Content Menu consists of options for managing Content.  This menu includes three 
options: 

 New 

The New Menu consists of two submenus:  New Item and Folder.  The Folder option 
is only available if you are in either the Site or the Folder node, or a Subfolder of one 
of these nodes.  The Folder option allows you to create a new Folder.  The New Item 
option lists all Content Types for which the current user has access to create a new 
Content Item.   

 Search 

This option launches a new Search. 

 <Site Name> 

This option is only available if you have selected a Site Folder or a Subfolder.  The name of 
this option is always the name of the Site node for the Folder you have selected. Submenu 
options available from this choice include options for changing the Display Format used in the 
Content Pane, options for creating new Content Items, and Access to the Folder Properties 
dialog so you can maintain the Properties of the Site (root) Folder. 

 View 
The View Menu includes two choices.  The Refresh option refreshes Content Explorer.  The 
Options choice activates the Display Options dialog, where you can modify the display 
settings for Content Explorer. 

 Site Explorer 
The Site Explorer menu option launches the Active Assembly interface in a new window.  
This interface allows you to browse through content as if it were published to a live Site.  All 
Content Items are available through Active Assembly, regardless of whether or not they are 
eligible to be Published.   

 Help 
The Help Menu includes two options.  The Content Explorer option activates the Content 
Explorer Help.  The About option activates the About Content Explorer dialog. 
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Creating Content Items 
Content Items are the basic units of content in Rhythmyx.  A Content Item is usually a portion of a page, 
such as a block of text, an image, or a banner, header, or footer.  In some cases, such as home pages, a 
Content Item may be a complete page, but more commonly, a Content Item is a portion of a page. 

By defining content in such a granular manner, Rhythmyx provides users greater control over the content.  
You can use the same Content Item in multiple ways on different pages.  Further, if editing is necessary, 
you only need to change the Content Item that needs to be modified, and do not disturb other parts of the 
page.   
 

Creating a Generic Page Content Item 
Let us begin by creating a simple Generic Page Content Item.   

You should always create new Content Items in a Folder so you can find them easily.  Rhythmyx does not 
require you to be in a Folder when you create a Content Item, but if you do not create the Content Item in 
a Folder, you will need to search for it or use a View to find it.  We will create our Content Item in a Site 
Folder. 

In the Navigation pane, expand the Sites node, and select the Enterprise Investments Site Folder.  Notice 
that when you select this Folder, the contents of the Folder are displayed in the Content Pane.  Double-
click on the "About Enterprise Investments" Folder.  We will create our new Content Item in this Folder 
for now. 

Percussion Software provides the content for this new Content Item, and several others we recommend 
that you create in the course of this walk-through.  The content is provided in a set of .txt files in the 
<Rhythmyxroot>/Samples/ffsamples directory.  If your Rhythmyx server is on a remote machine, you 
may want to copy the contents of this directory to your local machine.  We are going to use the tuition.txt 
file to provide the content for our example Content Item.  Open this text file in a simple text editor such as 
Notepad. 

To create your new Generic Page Content Item: 

1 In the Menu bar, choose Content > New > New Item > Generic. 
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Rhythmyx pops up a blank Generic Page Content Editor: 

 
Figure 71: Generic Content Editor 

2 Change to the Tuition.txt file, and copy the first line.  Change back to Content Editor and 
paste this text in the System Title field.  Paste it again into the Title field. 

3 Note that the Start Date defaults to the current date.  Do not change the value in this field. 

4 Change to the Tuition.txt file and copy the second line.  Change back to the Content Editor 
and paste this text into the Description field. 

5 Change to the Tuition.txt file and copy the third line.  Change back to the Content Editor and 
paste this text into the Callout field. 

6 Change to the Tuition.txt file and copy the text from the beginning of the third line to the end 
of the file.  Change back to the Content Editor and paste this text into the Body field. 

7 Click the [Insert] button.  You will be briefly redirected to a page asking you to wait a 
moment while your Content Item is uploaded to the repository, then redirected again the 
Content Editor. 

You have just added a new Content Item to the Rhythmyx Repository. 
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Near the bottom of the window the Content Editor now includes a set of links you can use to preview 
different formatted outputs of the Content Item.  For example, if you click the P - EI Generic link, 
Rhythmyx displays a window similar to this: 

 
Figure 72: Generic Content Item FF 

This page illustrates how the Content Item would look as a published Web page.   

If you click the S - Title Callout Link, you see a window similar to this: 

 
Figure 73: S - Title Callout Link 
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Both links launched the item in Active Assembly. Active Assembly consists of a two-panel interface that 
lets you actively edit content items directly on the page. For more detailed information on Active 
Assembly, see the Active Assembly Interface Help. 

Once finished reviewing the formats available for the new Content Item, click the [Close] button to close 
the Content Editor.  Note that the new Content Item, "Tuition Tax Credits and Deductions Offer Free 
Money from the IRS" has been added to the Enterprise Investments Folder. 
 

Creating a Generic Word Content Item 
Rhythmyx has been designed with enough flexibility that you can connect to third-party tools as Content 
Editors.  One of the most common tools used for creating content is Microsoft Word word processor.  The 
Generic Word Content Type provides the option of entering and maintaining Content Items using 
Microsoft Word.  We will enter Content from the sample Content File SavingForCollege.txt.  You should 
still be in the Enterprise Investments/About Enterprise Investments Folder to create this Content Item 

Note that before you can launch Word from Rhythmyx, you must update your security options.  In Internet 
Explorer choose Tools > Internet Options and click the Security tab: 

 make your Rhythmyx server a trusted site (Click the [Sites....] button then the [Advanced] 
button. In the Add this web site to the zone... dialog, enter http://localhost (or the name or IP 
address of the remote machine where your Rhythmyx server resides) and click [Add]. Click 
[OK] twice to return to the Security tab. 

 click the [Custom level...] button and on the Security Settings dialog, find the Download 
signed ActiveX controls entry.  Select either Enable or Prompt for this option. 

To create a Generic Word Content Item: 

1 In the Menu bar, choose Content > New > New Item > Generic Word. 

The Generic Word Content Editor uses an ActiveX control to launch Microsoft Word.  
Percussion Software has signed that this ActiveX control is safe, so click the [Yes] button 
when asked whether you want to run the control  After you click [Yes], Rhythmyx pops up a 
blank Generic Page Content Editor. 

2 Change to the SavingForCollege.txt file, and copy the first line.  Return to the Content Editor 
and paste the first line into the System Title field. 

3 Change to the SavingForCollege.txt file and copy the second line.  Return to the Content 
Editor and paste this text into the Callout field. 

4 Click the Launch Word link. 

Rhythmyx launches Microsoft Word.  Content editing using Microsoft Word requires the use 
of Word Styles to mimic fields in Rhythmyx. These styles are stored in the GenericWord 
template.  The template includes Word macros that convert the styles into Rhythmyx fields 
during the upload process.  You can implement your own Word-based Content Editors.  For 
details see the document Implementing Word in Rhythmyx.   

5 Change to the SavingForCollege.txt file, and copy the first line again.  Switch to the instance 
of Word and paste it.  Notice that the Style for this paragraph is PageDisplayTitle.  The 
content of this paragraph will be entered into that field in the Repository. 

6 Hit the <Enter> key on your keyboard.  The new paragraph has the Style PageAuthor.  In the 
Style drop list in Word, choose the style PageBody  
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7 Change to the SavingForCollege.txt file and copy from the beginning of the second line 
through the end.  Past this text into the Word document. 

8 In the Word button bar, click the Save to Rhythmyx button . 

9 Word displays a File Name dialog.  Enter the text SavingForCollege.  

10 Word displays a confirmation dialog: 

 
Figure 74: Confirmation dialog displayed when you have successfully uploaded your Content Item into 

Word 

11 Click the [Yes] button.  You will return to Rhythmyx, with the Saving For College Content 
Item displayed in the Content Pane.  The Content Item is located as the result of a background 
search; if you do not see it, click the Search Results node in the left pane. 

12 Right-click on the Saving For College Content Item and choose Edit from the popup menu. 

Rhythmyx displays the Saving For College Content Editor. 

13 Again, at the bottom of the Content Editor, you will find links for viewing this Content Item 
in Active Assembly in different formats.  Click on these links to view the formats available for 
the Content Item. 

14 When you have finished, click the [Close] button. 
 

Creating an Image Content Item 
Image Content Items are used to manage graphics used as content on Web pages.   

Note that some graphics are used within the page layout itself.  Examples include company logos and 
spacers used to define page layout.  These graphics, which are referred to as static images, are not 
managed by Rhythmyx, but reside on the Web server so they can be included in the Published pages.   

Content images, however, are managed as Content Items of the Image Content Type.  Once an Image 
Content Item exists in the system, you can use it in any Slot that allows Image Content Types. 

An example graphic (moneyroll.jpg) is included in the FastForward sample directory.  If you are 
connecting to your Rhythmyx server from a remote machine, you might want to copy this file to your 
local machine. 

To create the Image Content Item: 

1 In the Navigation Pane, expand the Enterprise Investments Site Folder, then expand the 
Images Site Folder.  Double-click on the People Folder. 

2 In the Menu bar, choose Content > New > New Item > Image. 
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Rhythmyx displays the Image Content Editor. 

 
Figure 75: Image Content Editor 

3 In the System Title and Title fields, enter Money Roll. 

4 Click the [Browse] button next to the Image field. 

Rhythmyx displays a browse dialog. 

5 Browse to the <Rhythmyxroot>/Samples/ffsamples directory, select the file moneyroll.jpg.and 
click the [Open] button. 

Rhythmyx adds the path and filename you specified (for example, 
C:\Rhythmyx\Samples\ffsamples\moneyroll.jpg). 

6 On the Content Editor window, click the [Insert] button. 
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7 Rhythmyx uploads the file and refreshes the Content Editor window.  Once the window has 
refreshed, the read-only fields Image File Name, Image Mime Type, Height, and Width include 
data. 

8 Click the [Close] button to close the Content Editor 

9 The new Money Roll Image Content Item has been added to the Folder. 
Two additional sample image files are included in the FastForward Samples directory, 
Girllookingatcamera.jpg and taxandglasses.jpg.  Add these as Image Content Items to the same Folder. 
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Working with Site Folders 
As discussed earlier, Folders are the fundamental mechanism Rhythmyx provides for users to organize 
and navigate content. Folders in Rhythmyx are similar to Folders in Microsoft Windows.  The major 
difference is that the folders in Windows are physical directories on the file system. Files in a folder in 
Windows are physically located in that Folder. 

In Rhythmyx, Folders define virtual locations you can use to organize and navigate content.  The Content 
always exists in the Repository, not in the Folders.  The Folders merely contain pointers to the physical 
Content Items stored in the Repository. 

The Navigation Pane includes two roots that contain Folders.  The Sites Root is used to define Site 
structures.  When you publish a Site, Rhythmyx creates a directory structure on the target server parallel to 
the Site Folder structure you have defined under this node.  Note that you can create a several Sites under 
this node, each of which can be published separately.  The Folders Root contains Folders that are used 
more generically for organization.  The Folders under this root are not published.   

Otherwise, Folders function identically regardless of the root to which they belong. 
 

Creating the Education Folder 
We want to create a new subsection (Education) for the Investment Advice section of our Web site.  This 
section will require a new directory to store the Web pages for the new section.  In Rhythmyx, we create 
the new section, and the new directory, by creating a new Folder. 

To create the new Education Folder: 

1 In the Navigation Pane, expand the Enterprise Investments node, and select the Investment 
Advice node. 

2 In the Menu bar, choose Content > New > Folder. 
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Rhythmyx displays the Create Folder dialog. 

 
Figure 76: Create folder dialog 

3 In the Folder Name field, enter Education.  You can enter a free-form Description if you wish, 
but that is not necessary.  Leave the defaults in all other fields. 

4 Click the [OK] button. 
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Rhythmyx adds the new Folder under Investment Advice.   

 
Figure 77: New Folder 

Double-click on the Education Folder.  Rhythmyx displays the contents of the Folder in the Content Pane.  
Notice that this Folder already has a Content Item, Education, of the Navon Content Type.  This Content 
Item is created automatically by the Managed Navigation functionality.  It is used to generate navigation 
for the Web site automatically when it is published.  For more about Managed Navigation see 
Maintaining Managed Navigation for the Education Folder (on page 94) and Sites and Managed 
Navigation.  
 

Moving Content into the Education Folder 
Since Web pages are published to the directory corresponding to the Site Folder in which they are located, 
we want to move the Content Items we previously created into the new Folder.   

Let us move the Tuition Content Item first.  To move the Tuition Content Item: 

1 Select the EnterpriseInvestments Folder. 

2 In the Navigation Pane, select the About Enterprise Investments Folder so you can see its 
contents in the Content Pane. 

3 In the Content Pane select the Tuition Content Item, and drag it to the 
InvestmentAdvice/Education Folder (as you drag the Content Item, you will notice a small 
dotted square below the mouse pointer; this square indicates that you are dragging the Content 
Item. 

4 Place the mouse pointer over the Education Folder and release. 

Rhythmyx pops up a dialog with the following options: 

 Move 

 As Link 

 As New Copy 
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5 Select the Move option. 

The Tuition Content Item is removed from the Content Pane. 

6 Select the Education Folder.  The Tuition Content Item has been moved to the new location. 

 
Figure 78: Content Explorer showing the Education Folder with the Tuition Content Item 

7 Use the same procedure to move the Saving for College Generic Word Content Item into the 
Education folder. 

8 Now go into the EnterpriseInvestments/Images/People folder and move the Money Roll, Girl 
Looking at Camera, and Tax and Glasses Content Items into the Education Folder. 
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Adding Additional Content to the Education Folder 
Two additional sample txt files, TenThingstoknow.txt and Section529Plans.txt are included in the 
Samples directory.  Use these to create two more Generic Page Content Items, "Important Things to Know 
About Saving for College" and "Section 529" Plans in the Education Folder.   

When you have created these Content Items, the Education Folder should resemble the following 
screenshot: 

 
Figure 79: Education Folder 
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Active Assembly 
Now that we have some Content Items, we want to create links between them.  In Rhythmyx, the process 
of creating these links is called Active Assembly.  When you use Active Assembly to link one Content 
Item to another, you are creating an Active Assembly Relationship between the two Content Items.   

Active Assembly Relationships are one category of associations between Content Items.  Rhythmyx 
provides the ability to create a variety of associations between Content Items.  Collectively, these 
associations are known as Relationships.  For more details about Relationships in general, see 
Implementing the Relationship Engine. 

An Active Assembly Relationship defines how one Content Item (referred to as the Dependent) will be 
included in another Content Item (which is called the Owner because it owns the Relationship) when the 
content is published.  Active Assembly is used for one of two reasons: 

 to embed one Content Item into another (typically used for graphics, but occasionally also 
used to embed text from one Content Item into another); 

 to create a link from one Content Item to another (such as a hypertext link between two pages, 
or call to a binary file to be displayed to the user). 

We will perform both types of Active Assembly, adding links between the pages we created and adding 
images to the pages.  
 

Adding Links to Other Generic Pages in the Sidebar Slot 
On the P - EI Generic Template, the Sidebar Slot is used to create links to other Content Items that contain 
content related to the topic on the current page.    Let's create a link from the Tuition Content Item to the 
other new Education Content Items we created. 

To create related content in the Sidebar Slot: 

1 In the Navigation Pane, select the Education Folder. 

2 Right-click on the Tuition Content Item and choose Edit from the popup menu. 

Rhythmyx displays the Tuition Content Editor. 

3 Scroll to the bottom of the Content Editor and click on the P - EI Generic link. 
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Rhythmyx displays the P - EI Generic format of the Tuition Content Item in the Active 
Assembly Interface. 

 
Figure 80: Adding Links to Generic Pages 

In Active Assembly, you can modify the Snippets (related content) in the Slots on this 
Template. 

4 Find the Sidebar Slot, and right-click the  icon, and choose Add Snippet from the drop 
menu.   
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Rhythmyx displays the Content Browser.   

 
Figure 81: Content Browser 

5 Click the Search tab. 
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Two versions of this tab are available.  If you installed the full-text search engine, you will 
see: 

 
Figure 82: Content Browser, Search Tab 

If you did not install the full-text search engine, your system uses the database search engine, 
and you will see: 
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Figure 83: Content Browser, Search tab 

6 If you have the Full-text Search engine, enter college into the Search for field.  If you have the 
database search engine, enter college into the Title field.  Click the [Search] button. 
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7 Rhythmyx returns the Search results: 

 
Figure 84: Search results 

8 We want to insert the Section 529 College Savings Plans content item, so we click it. 

A page that lets us choose the Template or format for the content item opens. It lists five 
Templates with which we can format the item: 

 S - Callout 

 S - Image Link 

 S - Title Callout and More Link  

 S - Title Callout Link 

 S - Title Link 
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Figure 85: Template selection page 

9 Click each option under Select a template to see in Template Preview how it formats the 
content item.  

We want to create a link to the specified page using the Title and Callout of the target Content 
Item, so we will use the S - Title Callout Link Template. 

10 Select S - Title Callout Link and click [Select]. 
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The Content Browser returns to the page of search results so you can add another item to the 
Slot.  If you move the Content Browser over so you can see the Sidebar Slot, you will see that 
the Section 529 College Savings Plans content item has been added to the Slot.   

 
Figure 86: Snippet added 

11 Repeat Steps 7 - 10, adding the Important things to know about saving for college content 
item in the format of the S - Title Callout Link template.   

12 When you return to the Search results, click [Back] to return to the search screen. Since you 
do not want to enter another search, click [Close]. 
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The Content Browser closes and the page for the Tuition Content Item now resembles: 

 
Figure 87: Snippets with links added to page 

Each new Snippet that you add to a Slot is inserted at the bottom of the Slot, so the Important 
things to know about saving for college Snippet appears below the Section 529 College 
Savings Plans.  

Each of the titles in the Snippets that you have added is a link to the Web page for that item. 
To see this press ALT and click on one of the Snippet titles. 

Rhythmyx opens the page that the title links to. 

13 When you have finished, close the Active Assembly window for the Tuition Content Item. 
 

Adding an Image to a Generic Page 
Now let us add an image to one of our Education Content Items.  In this case, let us add an image to the 
rich-text Body field of the Content Item. 

1 In the Navigation Pane, select the Education Folder. 

2 In the Content Pane, right-click on the Tuition Content Item and choose Edit from the popup 
menu. 

Rhythmyx displays the Tuition Content Editor. 

3 Scroll down to the Body field, and place the cursor before the first character in the field. 

4 Click the Insert Rhythmyx Image button . 

Rhythmyx displays the Content Search dialog.  
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5 If you have the Full-text Search Engine installed, enter glasses in the Search for field.  If you 
have the database search engine installed, enter glasses in the Title field.  Click the [Search] 
button. 

Rhythmyx displays the Search Results window. 

6 Click the Tax and Glasses radio button. (If you want to see a preview of this Content Item, 
click the Tax and Glasses link.)  Click the [Add] button. 

7 Rhythmyx adds the graphic to the Body field. 

8 Now let us format the graphic so it merges more smoothly with the text.  Right-click on the 
graphic and choose Image Properties from the popup menu. 

Rhythmyx displays the Image Properties window. 

9 In the Alignment drop list, choose Left. 

10 Click the [OK] button. 

11 The text will now flow around the graphic, similar to the following screenshot: 

 
Figure 88: Image added to Generic Page 

12 Click the [Update] button to upload the changes to the Repository. 
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13 When the changes have been uploaded, the Content Editor will refresh.  To check your 
changes, scroll down to the Preview links and click the P - EI Generic link.  The preview 
should resemble the following screenshot 

 
Figure 89: Graphic inserted 

Now, add the Money Roll Image to the 529 Content Item and add the Girl Looking at Camera Image to 
the Important Things... Content Item.  You may want to try alternative formatting for these images (for 
example, aligning right instead of left). 
 

Previewing the Content Item 
Now that we have added related content to our Content Items, let us preview them to see how they will 
look when published.   

To preview the Tuition Content Item: 

1 In the Navigation Pane of Content Explorer, open the Education folder. 

2 Right-click on the Tuition Content Item and on the popup menu choose Enterprise Preview > 
P - EI Generic. 
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3 Rhythmyx displays a preview of the Tuition Content Item. 

 
Figure 90: Content Item Preview 

Note that the page includes the graphic and the content items in the Sidebar Slot that we added.   

Click on the Important Things or Section 529 Content Item.  Rhythmyx displays previews of these pages.  
These previews give you an idea of how the pages will look when published.  Note, however, that when 
content is published, the related Content Items will only be included if they are Public.  The following 
section, which describes Workflow, explains how to make these new Content Items Public. 
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Workflow 
A Workflow is a business process that defines the life cycle of a Content Item.  In Rhythmyx, every 
Content Item must exist within a Workflow.  The Workflow defines: 

 the steps or stages in the processing of the Content Item; 
 which users can access the Content Item at a particular point in its life cycle; and 
 what different users can do to the Content Item at each point. 

Rhythmyx defines a Workflow as a series of stages, or States, which define the life of the Content Item.  
In each State, users in specific Roles have access to the Content Item.  Users in some Roles can modify 
the Content Item, while users in other Roles can only see and read the Content Item.  Users with the 
correct access can also Transition Content Items, moving them between States in a Workflow. 
 

Check In and Check Out 
The check in and check out functionality in Rhythmyx allows multiple users to have access to all Content 
Items, but prevents more than one user at a time from modifying a Content Item.  When a user checks out 
a Content Item, only that user can edit the Item; it is unavailable to all other users.   

Check in and check out are special types of Transitions.  Check in and check out do not move a Content 
Item from one State to another, as do normal Transitions.  Instead, check in sets a lock flag that indicates a 
user has the Content Item checked out.  Check in removes this flag. 

In many cases, Rhythmyx checks Content Items in and out automatically.  In a few cases (notably when 
initially creating a Content Item or after modifying the Content Item), you must check the Item in 
manually. 
 

About Roles 
A Role is a collection of users with the same access in Rhythmyx. In Workflows, Roles determine which 
users can access content in each State and which Transitions they can apply.  

Organizing users into Roles helps administrators manage users that have the same permissions. Instead of 
managing the permissions for each user, they define a Role its permissions, then assign users to it.  Users 
inherit their access rights from the Roles to which they are currently assigned. 
 

Transitioning Content Items to a New State 
Now that we have finished creating our Content Items and adding related content, we want to make them 
Public so we can publish them.  We will need to perform a Transition on the Content Item. 

To Transition the Tuition Content Item: 

1 In the Navigation Pane, go to the Education Folder. 

2 Right-click on the Tuition Content Item and on the popup menu, choose Workflow > Submit. 
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3 Rhythmyx displays a Workflow Comment window.  You can enter a free-form comment in 
this window. 

 
Figure 91: Workflow Comments Popup 

4 Click the [OK] button to continue making the Transition. 

5 Rhythmyx displays a message box informing you that it is processing the Tuition Content 
Item. 

6 When the message box disappears, the Transition is complete, and the Content Item is now in 
the Review State. 

Note that the Author1 user does not have rights to Transition the Content Item in the Review State.  If you 
right-click on the Tuition Content Item now and choose Workflow, the submenu lists No Entries. 

Repeat the process above for the remaining new Content Items (Important Things to Know, Section 529 
Plans, Money Roll, Tax and Glasses, Girl Looking at Camera, Saving for College). 
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About the Standard Workflow 
The Generic Page Content Type uses the Standard Workflow, one of two basic Workflows included with 
FastForward.  The Standard Workflow is a common structure that requires one approval before going to 
Public.   

 
Figure 92: Preview of Standard Workflow 

Note that the Standard Workflow includes a Pending State between the Review and Public States.  This 
State is included to support internationalized systems.  In some cases, internationalized systems require 
that Translations of Content Items be Published at the same time as the original.  The Pending State 
provides a holding area" for original Content Items while waiting for the Translations to be completed. 

The Public State is the State in which the Content Item is eligible to be Published.  When a Content Item 
reaches this State, it will be published the next time the Publisher runs. 

The Quick Edit State is provided to allow quick touch-ups to Content Items without forcing them through 
the complete Workflow again.  For example, if you find a misspelling or minor grammatical error on the 
Content Item, there is usually no need for it to go back through the complete approval process.  Instead, 
you can move it to Quick Edit, make your change, and return the Content Item to Public immediately.  
Note that your changes will not be reflected in the published output until the Content Item is re-published.   
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Finally, the Archive State provides a terminal State for Content Items after they have expired.  The 
Content Items continue to exist in the system, and if necessary can be revived.  (In the Standard 
Workflow, revised Content Items are returned to the Draft State and must go through the complete 
Workflow before they can return to Public.) 
 

Moving Content Items to Public 
As we noted above, when logged in as Author1, you cannot transition the Education Content Items from 
the Review State.  You must log in as a user with rights to Transition the Content Items in this State.  In 
this case, the user Editor1 has these rights.  Start a new browser session and log in as Editor1 (this user 
uses the standard password demo). 

(Note that you must start a new browser session.  While you can change the Community [and in 
internationalized environments, the Locale] of the user in the current session, each session is associated 
with a specific user.  In order to log in as a different user, you must start a new browser session.) 

Once you have logged in, go to the Education Folder. 

We are going to assume for our purposes that these Content Items are all ready to go Public.  Rather than 
Transition them individually, we can Transition them all at once.   

To Transition multiple Content Items: 

1 Select the Content Items you want to Transition.  In this case, we want to Transition all the 
Generic Page Content Items, the Generic Word Content Item, and the Image Content Items.  
The Content Explorer applet supports multi-select.  You can hold down the <CTRL> key 
while selecting Content Items, or if multiple Content Items are adjacent, select the first 
Content Item, then hold down the <Shift> key while selecting the last Content Item you want 
to select.  All Content Items in between will be selected as well. 

2 Right-click and from the popup menu, choose Workflow > Approve. 

When you multi-select, Content Explorer displays only the Transitions that all selected 
Content Items have in common.  In this case, the Content Items should have the following 
Transitions in common: 

 Check-out 

 Approve 

 Rework 

If the selected Content Items have no Transitions in common, when you select Workflow 
from the popup menu, the submenu option will be No Entries. 

3 Rhythmyx displays the Workflow Comment window.  If you enter a comment in this window, 
it will be added to the record for all selected Content Items.  You cannot enter different 
comments for different Content Items in the selection.  If you want to enter different 
comments for different Content Items, you must Transition them individually. 

4 Click the [OK] button. 

Rhythmyx displays a message window showing the Content Items it is Transitioning.  When 
the message window disappears, all selected Content Items have been Transitioned. 
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The selected Content Items are now in the Pending State.  Ordinarily, when using the Standard Workflow, 
you would allow Rhythmyx to move the Content Items to Public automatically using the Aging 
functionality.  In the Standard Workflow, an Aging Transition has been added from the Pending State to 
the Public State.  This Transition will automatically move the Content Items to Public based on the 
System Field Start Date.  Recall that we preserved the default Start Date, which is the current date, when 
we created our Content Items.  When the aging process on the Rhythmyx server (known as the Aging 
Agent) runs, it will find our Content Items, and note that their Start Date is the current date (or the past 
date when you created them).  Thus, it will move the Content Items to Public automatically.  The Aging 
Agent runs every ten minutes, so you may have to wait a few minutes for your Content Items to Transition 
automatically. 

If you don't want to wait, another Transition, Force to Public, is also available from the Pending State.  
The Force to Public State is only available to users in the Admin role, so if you want to force these 
Content Items to Public, you will have to start another browser session and log in as admin1 to have 
access to Transition these Content Items. 
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Maintaining Managed Navigation for the 
Education Folder 
Recall that when we created the Education Folder, Rhythmyx automatically created a Navon Content Item 
of the same name in the Folder. Navons are Content Items, and act like other Content Items in the system.  
They include Slots and have related Content Items assigned to them.  Navons also exist in a Workflow and 
can be Transitioned.  During assembly, however, Navons are treated somewhat differently.  Rhythmyx 
uses them to create a background XML document that it uses to apply navigation to published pages.   

To ensure that our Education Folder and its content are published correctly, we will need to assign a 
Content Item to the Landing Page Slot of the Education Navon, and we will have to make the Navon 
Public. 

Note that although the users author1 and editor1 could see the Education Navon, this Content Item 
actually exists in the Enterprise Investments Admin Community.  Since the users author1 and editor1 are 
members of the Enterprise Investments Community, they cannot access the Education Navon.  The user 
admin1, however, can log in to the Enterprise Investments Admin Community and thus can maintain this 
Content Item. If you still have a browser session for the admin1 user active, you can use that session.  
Otherwise, you will need to start a new browser session and log in as admin1.   

Regardless of whether you use an existing browser session or log in to a new session, you will need to 
change the Community admin1 is logged in to from Enterprise Investments to Enterprise Investments 
Admin.   
 

Creating a Landing Page for the Education Folder 
A landing page is the page you are directed to when you click on a link in the Navigation.  The landing 
page should have links to all of the other pages in the directory.   Use a Generic Page and assign all of the 
other Content Items in the Folder as related Content Items in the List Slot.  

Next, you must specify this page as the landing page for the Navon. 

To add a Landing Page to the Education Navon: 

1 In the Navigation Pane, go to the Education Folder. 

Navons generally act like normal Content Items in the system, so they include Slots.  
However, during assembly, Navons are used to create a background XML document that is 
used to add navigation to published pages.  They are never assembled into Snippets or Pages.  
Therefore, you cannot use the Active Assembly Preview to maintain the Slots on a Navon.  
You must use the Active Assembly Table Editor to add related content to the Slots on a 
Navon. 

2 Right-click on the Education Content Item and on the popup menu, choose Active Assembly 
Table Editor. 

 



 Chapter 5    A Brief Introduction to Rhythmyx 95 
 
 

3 Rhythmyx displays the Active Assembly Table Editor. 

 
Figure 93: Navon Table Editor 

4 Click the nav_landing_page link. 

5 Rhythmyx displays a search window.  Search on the term "tuition". 

6 The search results will only include S - Title Link Snippets.  Check the box for the Tuition 
Content Item and click the [Link to Slot] button. 
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7 The Tuition Content Item will be added to the nav_landing_page Slot on the Table Editor. 

 
Figure 94: Landing Page Added 

8 Close the table editor. 
To see how the landing page works, Preview the Enterprise Investments Home Page.  In the left 
navigation bar, you will see that Education has been added as a section under Investment Advice.  If you 
click on this link, you will be directed to the Tuition Tax Credits page, which includes links to the 
Education Content Items we added. 
 

Making the Education Navon Content Item Public. 
Before our new Education section can be published correctly, we need to make the Education Navon 
Public.  

Use the same procedure that you used to Transition the other Content Items.  Notice that when you choose 
Workflow from the popup menu, the submenu includes the option Direct to Public.  We will not be 
making any additional changes to the Education Navon, so use this Transition. 

When you are finished, all of the Content Items in the Education Folder, including the Education Navon, 
will be Public.  Now you are ready to publish this Site with the new Section. 
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Publishing the Web Site with the Education 
Section 
Now that we have added our new section, we are ready to publish the Web Site to include it.   

To publish the site, in Content Explorer, choose the Publishing tab and go to the Editions window.  In the 
Publish column of the Full Enterprise Investments Edition, click the run icon ( ). 

Rhythmyx redirects you to the Publisher Status page.  This page displays updates regarding the state of 
your publishing run. 

The run may take five to ten minutes to complete.  When it is complete, the Status page will state "Edition 
is no longer in progress."  Click the Publishing tab to return to the Publishing home page.  This page lists 
the Publishing logs.  You should see a new log entry with the date stamp of the time you initiated the run.  
If the value in the Status column is Success, then you have published your content successfully.  If the 
value is Error, then a problem occurred during the run. 
 

Successful Publisher Runs 
If the Publisher runs successfully, you will see a new subdirectory (Education) in the Investment Advice 
directory of your Publishing target location, by default:  
<Rhythmyx root> \AppServer\server\rx\deploy\EI_Home.war\   

 
Figure 95: Published Education Folder 

 



98 Rhythmyx Getting Started with Rhythmyx 
 

If you do not see this directory, then none of the Content Items in the Site Folder were published.  The 
most common reason for Content Items not to be published is that they are not in the Public State.  Go 
back to the Content Tab of Content Explorer and Transition all of the Content Items in the Education 
Folder to Public. 

Another reason that the Education directory might not be created is that it does not contain any Content 
Items.  Go back to the Content tab of Content Explorer and move the Education Content Items to the 
Education Folder.  

If you open the Education directory, you will see four new HTML pages.  The names of these files will be 
itemNNN.html.  The value of NNN will be the Content IDs of the Generic Page and Generic Word 
Content Items you created during this walk-through.  You will also see three new JPG pages. These are 
the image Content Items that you created. The values should resemble those in the graphic below: 

 
Figure 96: Contents of Education Folder 

If any of the Content Items you created are missing, either they are not Public or they are not in the 
Education Folder. 

If you access the home page by entering http://localhost:9992/EI_Home/index.html, and then click the 
Education link in the right navigation pane, your Tuition page will resemble the following: 

 
Figure 97: Published Tuition Content Item 
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Unsuccessful Publisher Runs 
If the value of the Status column is Error, your Publishing run failed.  See Troubleshooting/Publishing 
(see "Publishing" on page 104) for some hints for failed publishing runs. 
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C H A P T E R  6  

Troubleshooting 
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Installation 

Installer Cannot Connect to the Repository 
This indicates improper entry of the Server’s IP, User ID, or Password.  

Solution: 

For SQL Server, follow the next few steps to establish a connection: 

 Confirm the existence of the sa account through Microsoft’s Enterprise Manager Utility. 
 Confirm, and if necessary, change, the sa password. 
 Re-attempt connection to the Server.  If it still fails, confirm the port on which SQL Server is 

listening in Enterprise Manager: 
a) Select Tools > SQL Server Configuration Properties.  

The SQL Server Properties dialog opens to the General tab. 

b) Press the [Network Configuration] button. 

The SQL Server Network Utility dialog opens to the General tab. 

c) Highlight the TCP/IP protocol and press the [Properties] button. 

The Network Protocol Default Value Setup dialog opens.  

 
Figure 98: Network Protocol Default Value Setup dialog 

d) If the port number listed is not 1433, change it and press [OK]. 

e) Exit Enterprise Manager and restart SQL Server. 
 

 

 



 Chapter 6    Troubleshooting 103 
 
 

Installer Hangs 
In most cases, the Installer hangs because the system’s temporary directories do not have enough room for 
the installation. 

Solution: 
Initiate set up from a command prompt, and specify a new temporary directory. 

In Windows, use the command shown in the following graphic.  In the graphic “d” represents the drive on 
which the setup executable is located and “c” represents the installation drive. 

 

 
Figure 99: Temporary Directory Setup 

In Unix, enter: 
sh SetupUI.sh -is:tempdir /usr/home/Rhyth_User 
 

Server Shuts Down During Initialization 
Server encounters an error and shuts down during initialization 

Solution: 

Go to <Rhythmyx root>\AppServer\server\rx\log.  First open boot.log and look for error messages giving 
you details about the server shut down.  If you still need more information, go to server.log and read 
through any error messages. 
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Startup 

Rhythmyx License Period Expired 
On startup, the Rhythmyx Server displays the message, “The evaluation period for this license has 
expired.” 

Solution: 
This error indicates that your license for Rhythmyx has expired, and you need a new license.  Contact 
Percussion Technical Support for a new license and for instructions about updating your installation. 
 

Out-of-Memory Condition Displayed on Rhythmyx Startup 
The Rhythmyx Server console displays an out of memory condition when you attempt to start Rhythmyx. 

Solution: 
Start the Rhythmyx Server from a command line and specify at least 512 megabytes of RAM.  

In Windows, use the  following case-sensitive command: 

RhythmyxServer.exe –Xmx512m 
In Unix, create a file named RhythmyxServer.ja. In the file, include the line: 

-Xmx512m 
Run RhythmyxServer on a command line.  The command will automatically check for additional options 
in the RhythmyxServer.ja file and include them. 
 

Publishing 
Links in Publication Map are Broken 
The Publication Log in the Publishing Administrator indicates that files have published correctly, but links 
in the Publication Map to the files on the Web server are broken. 

Solution:  
Fix the Publishing Root Location or the Site Address (URL) on the Edit Site Page.  The Publishing Root 
Location must be an existing directory that an HTTP server listed in Site Address (URL) serves. Since we 
are publishing to a file system, the Publishing Root Location must be an absolute path (for example, 
c:/inetpub/wwwroot or /usr/local/web). 
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Difficulty Locating Publisher Error Logs 
You are having difficulty locating Publisher error logs. 

Solution: 
Different parts of the Publisher have different error logging.  The part of the system that encounters a 
failure determines which log records the error. The following table indicates where different system 
component errors are logged. 

System Component Definition Where system component logs 
Publishing errors 

Content Lists The content lists are ordinary 
Rhythmyx Query applications.   

Content lists  write serious errors to 
the PSLOGDAT table (if it is 
enabled), and they may generate trace 
files 

PubHandler The PubHandler is a loadable 
handler that manages the 
Publishing process.  It reads the 
content lists and generates SOAP 
messages to the Publisher. 

Generally, Loadable Handler errors 
go to the Rhythmyx server console. 

JBOSS server The default Publisher server. The JBOSS server has logs. These 
are generally in <Rhythmyx 
root>\AppServer\server\rx
\log.  Go to server.log and read 
through any error messages. 

Publisher -- The publisher's output goes  to the 
/<Rhythmyxroot>/AppServer
/server/deploy/publogs 
directory. There is one log for each 
edition, and the edition number (and 
Publishing run number) are in the file 
name. These are the logs that are 
linked from the Publication Details 
Map.  If anything fails (or is 
configured incorrectly) before the 
SOAP servlet calls the Publisher, 
there will be no log. 

RXPUBSTATUS Backend Rhythmyx table If all of the Publishing steps work, 
Rhythmyx adds a row to the 
RXPUBSTATUS table.  When this 
row is added, a new line appears in 
the Publication Log window.  
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